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RINGKASAN

Nandana Wiragotra, Jurusan Teknik Elektro Fakultas Teknik Universitas Brawijaya,
Agustus 2016, Pengendalian Suhu Pada Alat Pengering Biji Kopi Menggunakan Metode
Kontroler ON-OFF, Dosen Pembimbing: Erni Yudaningtyas dan Moch. Rusli.

Semakin berkembangnya teknologi saat ini memberikan dampak positif pada
perkembangan dunia elektronik khususnya di bidang sistem kontrol. Pada saat ini banyak
teknologi yang telah menggunakan alat otomatisasi kontrol. Hal tersebut disebabkan oleh
keinginan manusia untuk memenuhi kebutuhan dan mendapatkan fasilitas kemudahan dan
efisiensi dalam berbagai macam hal. Kopi merupakan salah satu hasil komoditi perkebunan
yang memiliki nilai ekonomis yang cukup tinggi di antara tanaman perkebunan lainnya dan
berperan penting sebagai sumber devisa negara. Kopi tidak hanya berperan penting sebagai
sumber devisa melainkan juga merupakan sumber penghasilan bagi tidak kurang dari satu
setengah juta jiwa petani kopi di Indonesia. Berdasarkan permasalahan cuaca yang seringkali
timbul pada proses pengeringan biji kopi di indonesia, maka penulis merancang sebuah alat
pengering biji kopi yang dapat dikontrol untuk mempertahakan suhu pengeringan secara
otomatis, sehingga proses pengeringan tidak terkendala oleh kondisi cuaca yang terjadi.
Sistem pengendalian suhu pada alat pengering biji kopi menggunakan metode kontrol On-
Off dapat melakukan proses pengeringan selama 10 jam dengan set point suhu sebesar 55°C
dan mempunyai respon plan Time Delay (Td) = 6 menit, Time Rise (Tr) = 9 menit, Time
Peak (Tp) = 12 menit dan Max Overshoot (Mp) = 59,19°C. Terjadi penyusutan berat biji
kopi sebesar 335 Gram pada saat sebelum dilakukan proses pengeringan dibandingkan
dengan setelah proses pengeringan.

Kata Kunci : Kopi, Pengeringan, Kontrol On-Off.



SUMMARY

Nandana Wiragotra, Departement of Electrical Engineering, Faculty of Engineering,
Universitas Brawijaya, Agustus 2016, The temperature control on a dryer coffee beans using
the ON-OFF Controller Method, Supervisor : Erni yudaningtyas dan Moch. Rusli.

The growth of the current technology provides a positive impact on the development of
electronic world especially in the field of control system. At this time the many technologies
that have been using the appliance control automation. This is caused by the desire of the
people to meet the needs and get the facilities ease and efficiency in various kinds of things.
The coffee is one of the results of the plantation commodities have economic value is high
enough among other plantation crops and play an important role as a source of foreign
exchange reserves. The coffee is not only important role as a source of foreign exchange
reserves but is also a source of income for not less than one and a half million coffee farmers
in Indonesia. Based on the problems that often arise in weather drying process coffee beans
in Indonesia, author designing a a hairdryer coffee beans that can be controlled to insist on
retaining most drying temperature automatically, so that the drying process is not hindered
by weather conditions that happen. The temperature control system on a dryer coffee beans
using On-Off control method can perform the drying process for 10 hours with set point
temperature of 550C and have the response plan Time Delay (Td) = 6 minutes, Time Rise
(Tr) = 9 minutes, Time Peak (TP) = 12 minutes and Max Overshoot (MP) = 59,190C. Severe
depletion occurs coffee beans of 335 grams at the time prior to the drying process compared
with after the drying process.

Keywords : Coffee, drying, On-Off Control.



BAB |
PENDAHULUAN

1.1. Latar Belakang

Semakin berkembangnya teknologi saat ini memberikan dampak positif pada
perkembangan dunia elektronik khususnya pada bidang sistem kontrol. Pada saat ini banyak
teknologi yang telah menggunakan alat otomatisasi kontrol. Hal tersebut disebabkan oleh
keinginan manusia untuk memenuhi kebutuhan dan mendapatkan fasilitas kemudahan dan
efisiensi dalam berbagai macam hal.

Kopi merupakan salah satu hasil komoditi perkebunan yang memiliki nilai ekonomis
yang cukup tinggi di antara tanaman perkebunan lainnya dan berperan penting sebagai
sumber devisa negara. Kopi tidak hanya berperan penting sebagai sumber devisa melainkan
juga merupakan sumber penghasilan bagi tidak kurang dari satu setengah juta jiwa petani
kopi di Indonesia.

Keberhasilan agribisnis kopi membutuhkan dukungan semua pihak yang terkait dalam
proses produksi kopi pengolahan dan pemasaran komoditas kopi. Upaya meningkatkan
produktivitas dan mutu kopi terus dilakukan sehingga daya saing kopi di Indonesia dapat
bersaing di pasar dunia.

Teknologi budi daya dan pengolahan kopi meliputi pemilihan bahan tanam kopi unggul,
pemeliharaan, pemangkasan tanaman dan pemberian penaung, pengendalian hama dan
gulma, pemupukan yang seimbang, pemanenan, serta pengolahan kopi pasca panen.
Pengolahan kopi sangat berperan penting dalam menentukan kualitas dan cita rasa kopi
(Rahardjo, 2012).

Saat ini, peningkatan produksi kopi di Indonesia masih terhambat oleh rendahnya mutu
biji kopi yang dihasilkan sehingga mempengaruhi pengembangan produksi akhir kopi. Hal
ini disebabkan, karena penanganan pasca panen yang tidak tepat antara lain proses
fermentasi, pencucian, sortasi, pengeringan, dan penyangraian. Selain itu spesifikasi
alat/mesin yang digunakan juga dapat mempengaruhi setiap tahapan pengolahan biji kopi.

Salah satu cara untuk menghasilkan biji kopi yang baik memerlukan proses
pengeringan, proses pengeringan pada biji kopi sendiri menggunakan suhu berkisar 47° C -
60° C agar didapatkan kopi yang dapat disimpan sebelum diolah kembali. Saat ini para petani



melakukan proses pengeringan biji kopi dengan cara konvensional yang membutuhkan
waktu relatif lama. Hal ini disebabkan pada saat proses pengeringan terhambat oleh cuaca
yang tidak menentu. Di Indonesia memiliki dua musim yaitu musim kemarau dan musim
hujan. Apabila matahari terik penjemuran biasanya berlangsung 10-14 hari. Dan ketika
musim hujan, proses pengeringan akan terhambat karena kurangnya sinar matahari yang
mengakibatkan proses pengeringan bisa berlangsung 3 minggu. Hal tersebut mengakibatkan
penurunan kuantitas dan kualitas hasil produksi biji kopi (Najiyati dan Danarti, 2004).
Berdasarkan permasalahan cuaca yang seringkali timbul pada proses pengeringan biji
kopi di indonesia, maka penulis merancang sebuah alat pengering biji kopi yang dapat
dikontrol untuk mempertahankan suhu pengeringan secara otomatis, sehingga proses
pengeringan tidak terkendala oleh kondisi cuaca yang terjadi. Penelitian ini menerapkan
sistem kontrol kendali suhu pada miniatur alat pengering biji kopi menggunakan kontroler
dengan metode On-Off yang diharapkan bisa menjadi solusi salah satu langkah pengolahan

pasca panen pada biji kopi.
1.2. Rumusan Masalah

1. Bagaimana merancang hardware sistem kontrol kendali suhu pada alat pengering
kopi menggunakan metode kontrol on-of?
2. Bagaimana merancang Software sistem kontrol kendali suhu pada alat pengering

kopi menggunakan metode kontrol on-of?
1.3. Batasan Masalah

Untuk menekankan pada objek pembahasan yang ada, maka pada penelitian ini diberikan
batasan masalah sebagai berikut:

1. Kapasitas berat biji kopi yang dikeringkan adalah 2 kg.

2. Menggunakan Heater sebagai pemanas ruangan pengering kopi.

3. Menggunakan Fan 12V untuk meratakan panas dalam ruangan pengering kopi.

4. Menggunakan sensor suhu DS18B20.

5. Pengendalian yang dilakukan adalah dengan cara mengaktifkan atau menonaktifkan
Heater pada plan pengeringan kopi dengan setpoint 55° C.

6. Jenis kopi yang digunakan pada pengujian menggunakan kopi robusta.

7. Parameter kadar air pada proses pengeringan tidak diperhitungkan.

8. Penelitian difokuskan pada pengendalian suhu pada plan pengeringan biji kopi
dengan menggunakan metode on-off hysterisis

9. Lama waktu proses pengeringan biji kopi selama 10 jam.



1.4. Tujuan

Pada penelitian ini diharapkan dapat merancang suatu sistem kendali suhu sesuai dengan
proses pengeringan yang diinginkan terhadap alat pengering biji kopi menggunakan
kontroler On-Off sehingga diharapkan dapat membantu dan mempermudah proses

pengeringan biji kopi.

1.5. Sistematika Penulisan

Agar penyusunan laporan skripsi ini dapat mencapai sasaran dan tidak menyimpang dari
judul yang telah ditentukan, maka diperlukan sistematika pembahasan yang jelas.

Pembahasan dalam skripsi ini secara garis besar adalah sebagai berikut:

BAB | : Pendahuluan

Menjelaskan tentang latar belakang, rumusan masalah, batasan masalah,

tujuan, manfaat dan sistematika penulisan.
BAB Il : Tinjauan Pustaka

Menjelaskan teori dasar yang berisi penjelasan tentang teori Kkopi,
pengeringan kopi, arduino uno, sensor suhu DS18B20, Heater, fan,
kontroler, dan kontroler ON-OFF.

BAB Il : Metode Penelitian dan Perancangan Alat

Menjelaskan tentang metodologi penelitian yang terdiri atas studi literatur,
perancangan alat, pembuatan alat, pengujian alat, pengambilan kesimpulan
dan saran, serta perancangan dan pembuatan alat yang meliputi prinsip

kerja alat, perancangan perangkat keras dan perangkat lunak.
BAB IV : Pengujian dan Analisis

Menjelaskan tentang pengujian alat dan analisis yang meliputi pengujian

bagian blok sistem secara keseluruhan.
BABV : Penutup

Menjelaskan tentang pengambilan kesimpulan sesuai dengan hasil
perealisasian dan pengujian alat sesuai dengan tujuan dan rumusan

masalah, serta pemberian saran untuk pengembangan.



BAB Il
TINJAUAN PUSTAKA

2.1. Kopi

Kopi merupakan salah satu jenis tanaman perkebunan yang sudah lama dibudidayakan
dan memiliki nilai ekonomis yang lumayan tinggi. Konsumsi kopi dunia mencapai 70%
berasal dari spesies kopi arabika dan 26% berasal dari spesies kopi robusta. Kopi berasal
dari Afrika, yaitu daerah pegunungan di Etopia. Namun, kopi sendiri baru dikenal oleh
masyarakat dunia setelah tanaman tersebut dikembangkan di luar daerah asalnya, yaitu
Yaman di bagian selatan Arab, melalui para saudagar Arab (Rahardjo, 2012).

Di Indonesia kopi mulai di kenal pada tahun 1696, yang di bawa oleh VOC. Tanaman
kopi di Indonesia mulai di produksi di pulau Jawa, dan hanya bersifat coba-coba, tetapi
karena hasilnya memuaskan dan dipandang oleh VOC cukup menguntungkan sebagai
komoditi perdagangan maka VOC menyebarkannya ke berbagai daerah agar para penduduk
menanamnya (Najiyanti dan Danarti, 2004).

Sistematika tanaman kopi robusta menurut Rahardjo, (2012) adalah sebagai berikut:

e Kingdom : Plantae

e Sub kingdom : Tracheobionita
e Divisi : Magnoliophyta
o Kelas : Magnoliopsida
e Sub Kelas : Astridae

e Ordo : Rubiaceace

e Genus : Coffea

e Spesies : Coffea robusta

Di dunia perdagangan dikenal beberapa golongan kopi, tetapi yang paling sering
dibudidayakan hanya kopi arabika, robusta, dan liberika. Pada umumnya, penggolongan
kopi berdasarkan spesies, kecuali kopi robusta. Kopi robusta bukan nama spesies karena

kopi ini merupakan keturunan dari berapa spesies kopi terutama Coffea canephora (Najiyati



dan Danarti, 2004). Menurut Aak (1980), terdapat empat jenis kopi yang telah
dibudidayakan, yakni:

2.1.1. Kopi Arabika

Kopi arabika merupakan kopi yang paling banyak di kembangkan di dunia maupun di
Indonesia khususnya. Kopi ini ditanam pada dataran tinggi yang memiliki iklim kering
sekitar 1350-1850 m dari permukaan laut. Sedangkan di Indonesia sendiri kopi ini dapat
tumbuh dan berproduksi pada ketinggian 1000 — 1750 m dari permukaan laut. Jenis kopi
cenderung tidak tahan Hemilia Vastatrix. Namun kopi ini memiliki tingkat aroma dan rasa

yang kuat.

2.1.2. Kopi Liberika

Jenis kopi ini berasal dari dataran rendah Monrovia di daerah Liberika. Pohon kopi
liberika tumbuh dengan subur di daerah yang memilki tingkat kelembapan yang tinggi dan
panas. Kopi liberika penyebarannya sangat cepat. Kopi ini memiliki kualitas yang lebih

buruk dari kopi Arabika baik dari segi buah dan tingkat rendemennya rendah.
2.1.3. Kopi Canephora (Robusta)

Kopi Canephora juga disebut kopi Robusta. Nama Robusta dipergunakan untuk tujuan
perdagangan, sedangkan Canephora adalah nama botanis. Jenis kopi ini berasal dari Afrika,
dari pantai barat sampai Uganda. Kopi robusta memiliki kelebihan dari segi produksi yang
lebih tinggi dibandingkan jenis kopi Arabika dan Liberika.

2.1.4. Kopi Hibrida

Kopi hibrida merupakan turunan pertama hasil perkawinan antara dua spesies atau
varietas sehingga mewarisi sifat unggul dari kedua induknya. Namun, keturunan dari
golongan hibrida ini sudah tidak mempunyai sifat yang sama dengan induk hibridanya. Oleh

karena itu, pembiakannya hanya dengan cara vegetatif seperti stek atau sambungan.
2.2. Pengeringan Biji Kopi

Pengeringan adalah proses pengeluaran air dari suatu bahan pertanian menuju kadar air
kesetimbangan dengan udara sekeliling atau pada tingkat kadar air dimana mutu bahan
pertanian dapat dicegah dari serangan jamur, enzim dan aktifitas serangga (Hederson &
Perry, 1976). Sedangkan menurut Hall (1957) dan Brooker dkk.,(1974), proses pengeringan

adalah proses pengambilan atau penurunan kadar air sampai batas tertentu sehingga dapat



memperlambat laju kerusakan bahan pertanian akibat aktivitas biologis dan kimia sebelum
bahan diolah atau dimanfaatkan.

Pengeringan adalah proses pemindahan panas untuk menguapkan kandungan air yang
dipindahkan dari permukaan bahan yang dikeringkan oleh media pengeringan yang biasanya
berupa panas. Tujuan pengeringan adalah mengurangi kadar air bahan sampai dimana
perkembangan mikroorganisme dan kegiatan enzim yang dapat menyebabkan pembusukan
terhambat atau terhenti. Dengan demikian bahan yang dikeringkan dapat mempunyai waktu
simpan yang lebih lama.

Pengeringan merupakan salah satu cara dalam teknologi pangan yang dilakukan dengan
tujuan pengawetan. Manfaat lain dari pengeringan adalah memperkecil volume dan berat
bahan dibanding kondisi awal sebelum pengeringan, sehingga akan menghemat ruang
(Rahman dan Yuyun, 2005).

Dalam pengeringan, keseimbangan kadar air menentukan batas akhir dari proses
pengeringan. Kelembapan udara nisbi serta suhu udara pada bahan kering biasanya
mempengaruhi keseimbangan kadar air. Pada saat kadar air seimbang, penguapan air pada
bahan akan terhenti dan jumlah molekul-molekul air yang akan diuapkan sama dengan
jumlah molekul air yang diserap oleh permukaan bahan. Laju pengeringan amat bergantung
pada perbedaan antara kadar air bahan dengan kadar air keseimbangan (Siswanto, 2004).

Semakin besar perbedaan suhu antara medium pemanas dengan bahan pangan semakin
cepat pindah panas ke bahan pangan dan semakin cepat pula penguapan air dari bahan
pangan. Pada proses pengeringan, air dikeluarkan dari bahan pangan dapat berupa uap air.
Uap air tersebut harus segera dikeluarkan dari atmosfer di sekitar bahan pangan yang
dikeringkan. Jika tidak segera keluar, udara di sekitar bahan pangan akan menjadi jenuh oleh
uap air sehingga memperlambat penguapan air dari bahan pangan yang memperlambat
proses pengeringan (Estiasih, 2009).

Kombinasi suhu dan lama pemanasan selama proses pengeringan pada komoditi biji-
bijian dilakukan untuk menghindari terjadinya kerusakan biji. Suhu udara, kelembaban
relatif udara, aliran udara, kadar air awal bahan dan kadar akhir bahan merupakan faktor
yang mempengaruhi waktu atau lama pegeringan (Brooker dkk., 1974).

Biji kopi yang telah dicuci mengandung air 55%, dengan jalan pengeringan kandungan
air dapat diuapkan, sehingga kadar air pada kopi mencapai 8-10%. Setelah dilakukan
pengeringan maka dilanjutkan dengan perlakuan pemecahan tanduk. Pengeringan pada kopi
biasanya dilakukan dengan tiga cara yaitu pengeringan secara alami, buatan, dan kombinasi

antara alami dan buatan.



2.3.  Arduino
2.3.1. Pengertian Arduino UNO R3

Arduino adalah pengendali mikro single-board yang bersifat open-source, diturunkan
dari Wiring platform, dirancang untuk memudahkan penggunaan elektronik dalam berbagai
bidang. Hardwarenya memiliki prosesor Atmel AVR dan Softwarenya memiliki bahasa
pemrograman sendiri. Arduino adalah kit mikrokontroler yang serba bisa dan sangat mudah
penggunaan nya. Untuk membuatnya diperlukan chip programmer (untuk menanamkan
bootloader Arduino pada chip).

ARDUINO merupakan single board hardware yang open-source dan juga Softwarenya
pun dapat kita nikmati secara opensource juga. Di sisi Software arduino dapat dijalankan
dimulti platform, yaitu linux, windows, atau juga mac. Hardware arduino merupakan
mikrokontroller yang berbasiskan AVR dari ATMEL yang didalamnya sudah diberi
bootloader dan juga sudah terdapat standart pin I/0O nya. Tampilan arduino uno ditunjukkan

dalam Gambar 2.1.
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Gambar 2.1. Tampilan Arduino Uno

Arduino Uno berbeda dari semua board Arduino sebelumnya, Arduino UNO tidak
menggunakan chip driver FTDI USB-to-serial. Sebaliknya, fitur-fitur Atmegal6U?2
(Atmega8U2 sampai ke versi R2) diprogram sebagai sebuah pengubah USB ke serial. Revisi
2 dari board Arduino Uno mempunyai sebuah resistor yang menarik garis 8U2 HWB ke
ground, yang membuatnya lebih mudah untuk diletakkan ke dalam DFU mode. Revisi 3 dari
board Arduino UNO memiliki fitur-fitur baru sebagai berikut:

e Pinout 1.0: ditambah pin SDA dan SCL yang dekat dengan pin AREF dan dua pin
baru lainnya yang diletakkan dekat dengan pin RESET, IOREF yang
memungkinkan shield-shield untuk menyesuaikan tegangan yang disediakan dari



board. Untuk ke depannya, shield akan dijadikan kompatibel/cocok dengan board
yang menggunakan AVR yang beroperasi dengan tegangan 5V dan dengan
Arduino Due yang beroperasi dengan tegangan 3.3V. Yang ke-dua ini merupakan
sebuah pin yang tak terhubung, yang disediakan untuk tujuan kedepannya.

e Sirkuit RESET yang lebih kuat.

e Atmega 16U2 menggantikan 8U2.

“Uno” berarti satu dalam bahasa Italia dan dinamai untuk menandakan keluaran
(produk) Arduino 1.0 selanjutnya. Arduino UNO dan versi 1.0 akan menjadi referensi untuk
versi-versi Arduino selanjutnya. Arduino UNO adalah sebuah seri terakhir dari board
Arduino USB dan model referensi untuk papan Arduino, untuk suatu perbandingan dengan
versi sebelumnya. Berikut adalah ringkasan dari arduino yang ditunjukkan dalam Tabel 2.1.

Tabel 2.1. Ringkasan Spesifikasi Arduino Uno

Mikrokontroler ATmega328

Tegangan pengoperasian 5V

Batas tegangan input 6-20V

Jumlah pin l/O digital 14 (6 di antaranya menyediakan keluaran PWM)
Jumlah pin input analog 6

Arus DC tiap pin I/O 40 mA

Arus DC untuk pin 3.3V 50 mA

Memori Flash iio:l(?ad(::megaﬂ&. sekitar 0.5 KB digunakan oleh
SRAM 2 KB (ATmega328)

EEPROM 1 KB (ATmega328)

Clock Speed 16 MHz

Sumber : www.arduino.cc

Referensi desain Arduino dapat menggunakan sebuah Atmega8, 168, atau 328, model
saat ini menggunakan Atmega328, tetapi Atmega8 ditampilkan pada skema sebagali

referensi. Konfigurasi pin identik pada semua ketiga prosesor tersebut.

2.3.2. Daya (Power)

Arduino UNO dapat disuplai melalui koneksi USB atau dengan sebuah power suplai
eksternal. Sumber daya dipilih secara otomatis. Suplai eksternal (non-USB) dapat diperoleh

dari sebuah adaptor AC ke DC atau battery. Adaptor dapat dihubungkan dengan



mencolokkan sebuah center-positive plug yang panjangnya 2,1 mm ke power jack dari

board. Kabel lead dari sebuah battery dapat dimasukkan dalam header/kepala pin Ground
(Gnd) dan pin Vin dari konektor POWER. Board Arduino UNO dapat beroperasi pada

sebuah suplai eksternal 6 sampai 20 Volt.

Jika disuplai dengan yang lebih kecil dari 7 V, kiranya pin 5 Volt mungkin mensuplai

kecil dari 5 Volt dan board Arduino UNO bisa menjadi tidak stabil. Jika menggunakan suplai

yang lebih dari besar 12 Volt, voltage regulator bisa kelebihan panas dan membahayakan

board Arduino UNO. Range yang direkomendasikan adalah 7 sampai 12 Volt. Pin-pin

dayanya adalah sebagai berikut:

VIN. Tegangan input ke Arduino board ketika board sedang menggunakan sumber
suplai eksternal (seperti 5 Volt dari koneksi USB atau sumber tenaga lainnya yang
diatur). Kita dapat menyuplai tegangan melalui pin ini, atau jika penyuplaian
tegangan melalui power jack, aksesnya melalui pin ini.

5V. Pin output ini merupakan tegangan 5 VVolt yang diatur dari regulator pada board.
Board dapat disuplai dengan salah satu suplai dari DC power jack (7-12V), USB
connector (5V), atau pin VIN dari board (7-12). Penyuplaian tegangan melalui pin
5V atau 3,3V membypass regulator, dan dapat membahayakan board. Hal itu tidak
dianjurkan.

3V3. Sebuah suplai 3,3 Volt dihasilkan oleh regulator pada board. Arus maksimum
yang dapat dilalui adalah 50 mA.

GND. Pin ground.

IOREF. Pin ini di papan Arduino memberikan tegangan referensi dengan yang
mikrokontroler beroperasi. Sebuah perisai dikonfigurasi dengan benar dapat
membaca pin tegangan IOREF dan pilih sumber daya yang tepat atau mengaktifkan
penerjemah tegangan pada output untuk bekerja dengan 5V atau 3.3V.ATmega328
mempunyai 32 KB (dengan 0,5 KB digunakan untuk bootloader). ATmega 328
juga mempunyai 2 KB SRAM dan 1 KB EEPROM (yang dapat dibaca dan ditulis
(RW/read and written) dengan EEPROM library).

ATmega328 memiliki 32 KB (dengan 0,5 KB digunakan untuk bootloader). Ini juga
memiliki 2 KB dari SRAM dan 1 KB EEPROM (yang dapat dibaca dan ditulis dengan
perpustakaan EEPROM ).



10

2.3.3. Input dan Output

Setiap 14 pin digital pada Arduino Uno dapat digunakan sebagai input dan output,
menggunakan fungsi pinMode(), digitalWrite(), dan digitalRead(). Fungsi-fungsi tersebut
beroperasi di tegangan 5 Volt. Setiap pin dapat memberikan atau menerima suatu arus
maksimum 40 mA dan mempunyai sebuah resistor pull-up (terputus secara default) 20-50
kOhm. Selain itu, beberapa pin mempunyai fungsi-fungsi spesial:

e Serial: 0 (RX) dan 1 (TX). Digunakan untuk menerima (RX) dan memancarkan
(TX) serial data TTL (Transistor-Transistor Logic). Kedua pin ini dihubungkan ke
pin-pin yang sesuai dari chip Serial Atmega8U2 USB-ke-TTL.

e External Interrupts: 2 dan 3. Pin-pin ini dapat dikonfigurasikan untuk dipicu sebuah
interrupt (gangguan) pada sebuah nilai rendah, suatu kenaikan atau penurunan yang
besar, atau suatu perubahan nilai. Lihat fungsi attachinterrupt() untuk lebih
jelasnya.

e PWM: 3, 5, 6, 9, 10, dan 11. Memberikan 8-bit PWM output dengan fungsi
analogWrite().

e SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). Pin-pin ini mensupport
komunikasi SPI menggunakan SPI library.

e LED: 13. Ada sebuah LED yang terpasang, terhubung ke pin digital 13. Ketika pin
bernilai HIGH LED menyala, ketika pin bernilai LOW LED mati.

Arduino UNO mempunyai 6 input analog, diberi label A0 sampai A5, setiapnya
memberikan 10 bit resolusi (contohnya 1024 nilai yang berbeda). Secara default, 6 input
analog tersebut mengukur dari ground sampai tegangan 5 Volt, dengan itu mungkin untuk
mengganti batas atas dari range dengan menggunakan pin AREF dan fungsi
analogReference(). Di sisi lain, beberapa pin mempunyai fungsi spesial:

e TWI: pin A4 atau SDA dan pin A5 atau SCL. Mensupport komunikasi TWI dengan
menggunakan Wire library.

e AREF. Referensi tegangan untuk input analog. Digunakan dengan
analogReference().

e Reset. Membawa saluran ini LOW untuk mereset mikrokontroler. Secara khusus,
digunakan untuk menambahkan sebuah tombol reset untuk melindungi yang

memblock sesuatu pada board.
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2.3.4. Komunikasi

Arduino UNO mempunyai sejumlah fasilitas untuk komunikasi dengan sebuah
komputer, Arduino lainnya atau mikrokontroler lainnya. Atmega 328 menyediakan serial
komunikasi UART TTL (5V), yang tersedia pada pin digital 0 (RX) dan 1 (TX). Sebuah
Atmega 16U2 pada channel board serial komunikasinya melalui USB dan muncul sebagai
sebuah port virtual ke Software pada komputer. Firmware 16U2 menggunakan driver USB
COM standar, dan tidak ada driver eksternal yang dibutuhkan. Bagaimanapun, pada
Windows, sebuah file inf pasti dibutuhkan. Software Arduino mencakup sebuah serial
monitor yang memungkinkan data tekstual terkirim ke dan dari board Arduino. LED RX dan
TX pada board akan menyala ketika data sedang ditransmit melalui chip USB-to-serial dan
koneksi USB pada komputer (tapi tidak untuk komunikasi serial pada pin 0 dan 1).

Sebuah Software serial library memungkinkan untuk komunikasi serial pada beberapa
pin digital UNO. Atmega328 juga mensupport komunikasi 12C (TWI) dan SPI. Software
Arduino mencakup sebuah Wire library untuk memudahkan menggunakan bus I12C, lihat

dokumentasi untuk lebih jelas. Untuk komunikasi SPI, gunakan SPI library.
2.3.5. Pemrograman

Arduino UNO dapat diprogram dengan Software Arduino (download). Pilih “Arduino
Uno dari menu Tools > Board (termasuk mikrokontroler pada board). Untuk lebih jelas, lihat
referensi dan tutorial. ATmega328 pada Arduino Uno hadir dengan sebuah bootloader yang
memungkinkan kita untuk mengupload kode baru ke ATmega328 tanpa menggunakan
pemrogram hardware eksternal. ATmega328 berkomunikasi menggunakan protokol
STK500 asli (referensi, file C header). Contoh program pada arduino ditunjukkan dalam
Gambar 2.2.

oid setup () {
pinMode (LED P OUTPUT ) ep dig P
}
oid loop ()
digitalWrite (LED PIN, HIGH) s LE
delay (1€ ) ne second millisecon ds
digitalWrice (LED PIN, LOW 4 e LED
delay (1000) e second

Gambar 2.2. Contoh Program Pada Arduino
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Kita juga dapat membypass bootloader dan program mikrokontroler melalui
kepala/header ICSP (In-Circuit Serial Programming); lihat instruksi untuk lebih jelas
Sumber kode firmware ATmegal6U2 (atau 8U2 pada board revisi 1 dan revisi 2) tersedia.
ATmegal6U2/8U2 diload dengan sebuah bootloader DFU, yang dapat diaktifkan dengan:

e Pada board Revisi 1: Dengan menghubungkan jumper solder pada belakang board
(dekat peta Italy) dan kemudian mereset 8U2.

e Pada board Revisi 2 atau setelahnya: Ada sebuah resistor yang menarik garis HWB
8U2/16U2 ke ground, dengan itu dapat lebih mudah untuk meletakkan ke dalam
mode DFU. Kita dapat menggunakan Software Atmel’s FLIP (Windows) atau
pemrogram DFU (Mac OS X dan Linux) untuk meload sebuah firmware baru. Atau
kita dapat menggunakan header ISP dengan sebuah pemrogram eksternal
(mengoverwrite bootloader DFU). Lihat tutorial user-contributed ini untuk

informasi selengkapnya.
2.3.6. Reset Otomatis

Dari pada mengharuskan sebuah penekanan fisik dari tombol reset sebelum sebuah
penguploadan, Arduino Uno didesain pada sebuah cara yang memungkinkannya untuk
direset dengan Software yang sedang berjalan pada pada komputer yang sedang terhubung.
Salah satu garis kontrol aliran hardware (DTR) dari ATmega8U2/16U2 dihubungkan ke
garis reset dari ATmega328 melalui sebuah kapasitor 100 nanofarad. Ketika saluran ini
dipaksakan (diambil rendah), garis reset jatuh cukup panjang untuk mereset chip. Software
Arduino menggunakan kemampuan ini untuk memungkinkan kita untuk mengupload kode
dengan mudah menekan tombol upload di Software Arduino. Ini berarti bahwa bootloader
dapat mempunyai sebuah batas waktu yang lebih singkat, sebagai penurunan dari DTR yang
dapat menjadi koordinasi yang baik dengan memulai penguploadan.

Pengaturan ini mempunyai implikasi. Ketika Arduino Uno dihubungkan ke sebuah
komputer lain yang sedang running menggunakan OS Mac X atau Linux, Arduino Uno
mereset setiap kali sebuah koneksi dibuat dari Software (melalui USB). Untuk berikutnya,
setengah-detik atau lebih, bootloader sedang berjalan pada Arduino UNO. Ketika Arduino
UNO diprogram untuk mengabaikan data yang cacat/salah (contohnya apa saja selain sebuah
penguploadan kode baru) untuk menahan beberapa bit pertama dari data yang dikirim ke
board setelah sebuah koneksi dibuka. Jika sebuah sketch sedang berjalan pada board

menerima satu kali konfigurasi atau data lain ketika sketch pertama mulai, memastikan
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bahwa Software yang berkomunikasi menunggu satu detik setelah membuka koneksi dan
sebelum mengirim data ini.

Arduino Uno berisikan sebuah jejak yang dapat dihapus untuk mencegah reset otomatis.
Pad pada salah satu sisi dari jejak dapat disolder bersama untuk mengaktifkan kembali. Pad
itu diberi label “RESET-RN” Kita juga dapat menonaktifkan reset otomatis dengan
menghubungkan sebuah resistor 110 ohm dari tegangan 5V ke garis reset; lihat thread forum

ini untuk lebih jelasnya.

2.3.7 Proteksi Arus USB

Arduino UNO mempunyai sebuah sebuah sekring reset yang memproteksi port USB
komputer dari hubungan pendek dan arus lebih. Walaupun sebagian besar komputer
menyediakan proteksi internal sendiri, sekring menyediakan sebuah proteksi tambahan. Jika
lebih dari 500 mA diterima port USB, sekring secara otomatis akan memutuskan koneksi

sampai hubungan pendek atau kelebihan beban hilang.

2.3.8. Karakteristik Fisik

Panjang dan lebar maksimum dari PCB Arduino UNO masing-masingnya adalah 2.7
dan 2.1 inci, dengan konektor USB dan power jack yang memperluas dimensinya. Empat
lubang sekrup memungkinkan board untuk dipasangkan ke sebuah permukaan atau kotak.
Sebagai catatan, bahwa jarak antara pin digital 7 dan 8 adalah 160 milimeter, bukan sebuah
kelipatan genap dari jarak 100 milimeter dari pin lainnya.

(www.arduino.cc/en/Main/ArduinoBoardUno, 2016)

24. Heater

Electrical Heating Element (elemen pemanas listrik) banyak dipakai dalam kehidupan
sehari-hari, baik didalam rumah tangga ataupun peralatan dan mesin industri. Bentuk dan
type dari Electrical Heating Element ini bermacam macam disesuaikan dengan fungsi,
tempat pemasangan dan media yang akan di panaskan.

Panas yang dihasilkan oleh elemen pemanas listrik ini bersumber dari kawat
ataupun pita bertahanan listrik tinggi (Resistance Wire) biasanya bahan yang digunakan
adalah niklin yang dialiri arus listrik pada kedua ujungnya dan dilapisi oleh isolator listrik
yang mampu meneruskan panas dengan baik hingga aman jika digunakan. Ada 2 macam

jenis utama pada elemen pemanas listrik ini yaitu:


http://www.arduino.cc/en/Main/ArduinoBoardUno
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2.4.1. Elemen Pemanas Listrik Bentuk Dasar

Yaitu elemen pemanas dimana Resistance Wire hanya dilapisi oleh isolator listrik,
macam-macam elemen pemanas bentuk ini adalah : Ceramik Heater, Silica Dan Quartz
Heater, Bank Channel Heater, Black Body Ceramik Heater. Berikut adalah beberapa contoh
dari heater bentuk dasar ditunjukkan dalam Gambar 2.3, 2.4 dan 2.5.

Gambar 2.3 Coil Heater

Gambar 2.5 Infra Red Heater
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2.4.2. Elemen Pemanas Listrik Bentuk Lanjut

Yaitu merupakan elemen pemanas dari bentuk dasar yang dilapisi oleh pipa atau
lembaran plat logam untuk maksud sebagai penyesuain terhadap penggunaan dari elemen
pemanas tersebut. Bahan logam yang biasa digunakan adalah : mild stell, stainless stell,
tembaga dan kuningan. Heater yang termasuk dalam jenis ini adalah :

a. Tubular Heater

b. Catridge Heater

c. Band, Nozzle & Stripe Heater

Bentuk dari heater diatas ditunjukkan dalam Gambar 2.6, 2.7 dan 2.8.

Gambar 2.6 Tubular Heater

Gambar 2.7 Catridge Heater



Gambar 2.8 Band, Nozzle & Strip Heater

2.5. Sensor Suhu DS18B20

Kebanyakan sensor suhu memiliki tingkat rentang terukur yang sempit serta akurasi
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yang rendah namun memiliki biaya yang tinggi. Sensor suhu DS18B20. dengan kemampuan

tahan air (waterproof) cocok digunakan untuk mengukur suhu pada tempat yang sulit, atau

basah. Karena output data sensor ini merupakan data digital, maka kita tidak perlu khawatir

terhadap degradasi data ketika menggunakan untuk jarak yang jauh. DS18B20 menyediakan

9 bit hingga 12 bit yang dapat dikonfigurasi data.

Karena setiap sensor DS18B20 memiliki silicon serial number yang unik, maka

beberapa sensor DS18B20 dapat dipasang dalam 1 bus. Hal ini memungkinkan pembacaan

suhu dari berbagai tempat. Meskipun secara datasheet sensor ini dapat membaca bagus

hingga 125°C, namun dengan penutup kabel dari PVVC disarankan untuk penggunaan tidak
melebihi 100°C. Bentuk sensor suhu ditunjukkan dalam Gambar 2.9.

Adapun spesifikasi dari sensor suhu DS18B20 adalah sebagai berikut:

Gambar 2.9 Sensor Suhu DS18B20

Tegangan yang dibutuhkan sensor dari 3.0V sampai 5.5V power/data
Akurasinya £0.5°C sampai -10°C, dan -10°C sampai +85°C
Batas temperatur sensor dari -55 sampai 125°C atau -67°F sampai +257°F

menyediakan 9 bit hingga 12 bit yang dapat dikonfigurasi data
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e  Menggunakan 1 kabel Antarmuka (Interface) dan hanya 1 digital pin untuk
komunikasi
e Data pengenalan Identitas yang disimpan 64 bit
e  Memiliki batas peringatan jika suhu tinggi
o  Temperature-limit alarm system
e  Waktu tunggu data masuk 750ms
e  kabel antarmuka (Interface):
»  Kabel merah :VCC
»  Kabel hitam : GND
»  Kabel putih : DATA

Bahan stainless steel silinder 6mm diametenya panjang 35mm

Diameter kabel : 4mm

Panjang kabel : 90cm
2.6. Fan

Dalam suatu ruangan yang membutuhkan pengendalian terhadap suhu, maka suhu
didalam ruangan haruslah merata agar suhu yang terbaca sesuai dengan suhu disetiap sudut
ruang. Masalahnya adalah jika ruangan terlalu besar, butuh waktu yang sangat lama untuk
suhu menjadi stabil dan sama nilainya disetiap sudut ruang. Untuk mempercepat hal ini
dirancanglah sebuah blower yang terdiri dari kipas DC yang akan merasakan panas didalam
ruang. Kipas DC ini terhubung dengan relay sebagai saklar otomatis jika sudah tidak

digunakan lagi.
2.7. Kontroler

Sistem pengendalian dirancang untuk melakukan dan menyelesaikan tugas tertentu.
Syarat utama sistem pengendalian adalah harus stabil. Disamping kestabilan mutlak, maka
sistem harus memiliki kestabilan secara relatif, yakni tolak ukur kualitas kestabilan sistem
dengan menganalisis sampai sejauh mana batas-batas kestabilan sistem tersebut jika dikenai
gangguan (Ogata K.,1997). Selain itu analisis juga dilakukan untuk mengetahui bagaimana
kecepatan sistem dalam merespon input, dan bagaimana peredaman terhadap adanya
lonjakan (over shoot).

Suatu sistem dikatakan stabil jika diberi gangguan maka sistem tersebut akan kembali
ke keadaan steady state di mana output berada dalam keadaan tetap seperti tidak ada

gangguan. Sistem dikatakan tidak stabil jika outputnya berosilasi terus menerus ketika
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dikenai suatu gangguan. Karena suatu sistem pengendalian biasanya melibatkan
penyimpanan energi maka output sistem ketika diberi suatu input, tidak dapat mengikuti
input secara serentak, tapi menunjukkan respons transien berupa suatu osilasi teredam
sebelum mencapai steady state.

Prinsip kerja kontroler adalah membandingkan nilai aktual keluaran plan dengan nilai
referensi. Kemudian kontroler menentukan nilai kesalahan dan akhirnya menghasilkan

sinyal kontrol untuk meminimalkan kesalahan (Ogata, 1997).

2.7.1. Kontroler On-Off

Karakteristik kontroler on—off ini hanya bekerja pada 2 posisi, yaitu on dan off. Kerja
kontroler on—off banyak digunakan pada aksi pengendalian yang sederhana karena harganya
murah. Karena sistem kerja yang digunakan adalah on — off saja, hasil output dari sistem
pengendalian ini akan menyebabkan proses variabel tidak akan pernah konstan. Besar
kecilnya fluktuasi proses variabel ditentukan oleh titik dimana kontroler dalam keadaaan on
dan off. Pengendalian dengan aksi kontrol ini juga menggunakan feedback. Adapun sinyal
aksi kontroler on-off dimana terdapat perbandingan keadaan sekarang atau Current Value

terhadap waktu dalam satuan detik. Ditunjukkan pada gambar 2.10

CV % A
open
close >
t (dtk)

Gambar 2.10 Aksi Kontroler on-off

Pada pengontrolan menggunakan metode on-off mempunyai nilai CV (control value)
yang bernilai 1 (open) atau O (close) seperti yang ditunjukkan dalam Gambar 2.10. Pada
penelitian ini nilai CV digunakan untuk mengaktifkan atau menonaktifkan heater yang

berfungsi sebagai aktuator dalam pengontrolan suhu pengeringan biji kopi.



BAB IlI
METODE PENELITIAN
3.1. Metode Penelitian

Kajian dalam skripsi ini merupakan penelitian yang bersifat aplikatif, yaitu merancang
dan membuat suatu alat pengeringan biji kopi dengan menitikberatkan pengendalian suhu
dengan menggunakan kontroler ON-OFF yang bertujuan agar dapat menampilkan
performansi sistem sesuai dengan yang direncanakan.

Langkah-langkah yang perlu dilakukan untuk merealisasikan alat yang akan dibuat
adalah sebagai berikut:

1. Spesifikasi alat
2. Perancangan dan realisasi pembuatan alat
3. Pengujian alat

4. Pengambilan kesimpulan

3.2. Spesifikasi Alat
Adapun spesifikasi alat yang akan direalisasikan adalah sebagai berikut:

1. Mikrokontroler yang digunakan untuk mengatur proses otomatisasi adalah Arduino
Uno.

2. Aktuator yang digunakan untuk memanaskan plan adalah heater 300 watt.

3. Sensor suhu yanng digunakan untuk membaca suhu pada ruangan pemanas adalah
DS18B20.

4.  Pada sistem pemanas menggunakan Fan 12V yang digunakan untuk meratakan panas
pada seluruh bagian ruangan.

5.  Pemrograman menggunakan compiler arduino.ide

18]
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3.3. Perancangan dan Realisasi Pembuatan Alat
3.3.1. Perancangan Perangkat Keras

a. Pembuatan diagram blok secara lengkap
b. Penentuan dan perhitungan komponen yang akan digunakan

c. Merakit perangkat keras (hardware) untuk masing-masing blok.
3.3.2 Perancangan Perangkat Lunak

Perancangan perangkat lunak dilakukan setelah mengetahui nilai parameter setpoint
suhu, hysteresis high, hysteresis low. Perancangan dimulai dari pembuatan flowchart,

kemudian dilanjutkan dengan penulisan listing coden pada compiler arduino.ide.

3.4. Pengujian Alat

Setelah semua komponen pada alat sudah terhubung sesuai dengan diagram blok sistem
yang telah dirancang dan perangkat lunak untuk mendukung sistem yang telah dibuat, maka

diadakan pengujian dan analisa alat. Metode pengujiannya adalah sebagai berikut:

3.4.1. Pengujian Catu Daya Tegangan

Pengujian catu daya dilakukan dengan cara menghubungkan dengan multimeter
pengukur tegangan. Pengujian ini bertujuan untuk mengetahui tegangan yang dihasilkan

output power supply. Power supply yang akan diuji adalah power supply 12V.
3.4.2. Pengujian LCD 16x2

Pengujian LCD 16x2 dilakukan dengan cara menghubungkan arduino uno dengan
LCD16x2. Arduino diprogram untuk menampilkan karakter tulisan pada LCD 16x2.
Pengujian ini bertujuan untuk mengetahui apakah LCD16x2 sudah dapat berfungsi sesuai

dengan yang diharapkan.
3.4.3. Pengujian Modul Relay

Pengujian modul relay dilakukan dengan cara menghubungkan modul relay dengan
arduino. Dimana arduino akan mengirimkan sinyal logika 1 dan 0 pada modul relay.
Pengujian ini bertujuan untuk mengetahui apakah modul relay yang dirancang sudah dapat

berfungsi sesuai dengan yang diharapkan.
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3.4.4. Pengujian Sensor Suhu DS18B20

Pengujian sensor suhu DS18B20 dilakukan dengan cara membandingkan pembacaan
suhu oleh DS18B20 dan termometer. Pengujian ini bertujuan untuk mengetahui karakteristik
dari sensor suhu DS18B20.

3.4.5. Pengujian Sistem Keseluruhan

Pengujian ini dilakukan dengan cara menggabungkan semua bagian alat yang dibuat dan
melihat Kinerja alat. Pengujian ini bertujuan untuk mengetahui kinerja alat yang dibuat dan

memberikan analisa terhadap kinerja alat.

3.5. Pengambilan Kesimpulan

Kesimpulan diambil berdasarkan data yang diperoleh dari pengujian sistem secara
keseluruhan. Jika hasil yang didapatkan telah sesuai dengan yang direncanakan sebelumnya,
maka sistem kendali tersebut telah berhasil memenuhi harapan dan tentunya memerlukan

pengembangan lebih lanjut untuk penyempurnaan.
3.6. Spesifikasi Sistem Kontrol

Spesifikasi sistem kontrol yang dirancang adalah:

1. Menggunakan metode kontrol on-off dalam proses pengeringan biji kopi.

2. Setpoint suhu proses pengeringan biji kopi ditetapkan 55°C.

3. Menggunakan parameter hysteresis dalam pengendalian suhu pengeringan biji
kopi.

4. Aksi kontrol berupa logika 1(on) atau O(off) untuk mengaktifkan dan
menonaktifkan Heater.

5. Waktu proses pengeringan biji kopi selama 10 jam.
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3.7. Diagram Blok Sistem

Diagram blok secara umum ditunjukkan dalam Gambar 3.1.

KONTROLLER DRIVER HEATER + RUANG PENGERINGAN

+Tx SUHU (°C)

0-5V DC 0-220V AC

To(°C)

SETPOINT (°C)

TSp (°C)

SENSOR

To (DATA DIGITAL) To (°C)

A

A

Gambar 3.1 Diagram Blok Sistem secara Umum (Perancangan, 2016)

Keterangan diagram blok dalam Gambar 3.1 adalah:

Setpoint berupa nilai parameter suhu yang sudah ditentukan nilainya.

Sinyal feedback dari sensor berupa nilai bobot Present Value (PV) pembacaan sensor
suhu yang diumpan balikkan.

Error berupa simpangan antar bobot sensor Present Value (PV) dengan nilai acuan
(SP).

Metode kontrol yang digunakan adalah On-Off dengan menggunakan arduino uno
sebagai pengendali utama.

Sensor yang digunakan adalah sensor suhu DS18B20.

Aktuator berupa Heater dan fan sebagai penghasil panas dalam sistem pengeringan
biji kopi.

Plan berupa kopi yang akan dikeringkan.

Output berupa nilai digital “0” atau “1” atau logika digital yang berfungsi untuk

mengktifkan sistem pemanas.

3.8. Pembuatan Perangkat Keras

Perangkat keras terdiri dari mekanik plan pengering biji kopi, board arduino uno,
Sensor suhu DS18B20, driver relay, LCD 16x2.

3.8.1.

Pembuatan Mekanik

Perancangan mekanik dilakukan sebagai dasar dari komponen-komponen yang akan

diletakkan. Secara umum ilustrasi mekanik plan sistem pengeringan biji kopi ditunjukkan

dalam Gambar 3.2.
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BOX CONTROL

.

Gambar 3.2 llustrasi Mekanik Plan Sistem Pengeringan Biji Kopi

3.8.2. Pembuatan Rangkaian Sistem Keseluruhan

Perancangan rangkaian sistem keseluruhan bertujuan agar sistem dapat bekerja sinkron
dengan fungsi masing-masing komponen. Yang pada akhirnya sistem dapat berjalan sesuai
dengan apa yang diharapkan. Adapun rangkaian sistem keseluruhan ditunjukkan dalam
Gambar 3.3.

T L,

||||u:1||||||| .

e

? =i

Gambar 3.3 Rangkaian Sistem Keseluruhan (Perancangan, 2016)

Berdasarkan hasil perancangan rangkaian sistem keseluruhan dapat diketahui bahwa
arduino uno dibagi menjadi 2 (dua) fungsi sistem, yaitu fungsi masukan dan keluaran. Pin
masukan dan keluaran pada perancangan ditunjukkan dalam Tabel 3.1.
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Tabel 3.1 Fungsi Pin Arduino Uno (Perancangan, 2016)
No. | Pin | Fungsi

1 D2 | Input Sensor Suhu DS18B20

2 D3 | Output Pin RS LCD

3 | D4 | OutputPinE LCD

4 D5 | Output Pin D4 LCD

5 D6 | Output Pin D5 LCD

6 D7 | Output Pin D6 LCD

7 D8 | Output Pin D7 LCD

8 D9 | Output Relay Heater

9 D10 | Output Relay Fan

3.8.3. Pembuatan Rangkaian Driver Relay

Driver relay berfungsi sebagai isolator antara tegangan kecil (5VDC) dengan tegangan
yang lebih besar (12VVDC). Perancangan rangkaian driver relay pada peneletian ini berfungsi
untuk mengaktifkan Heater dan fan pada sistem pemanas. Rangkaian driver relay

ditunjukkan dalam Gambar 3.4.

+ -8)

I o=
T 1

Gambar 3.4 Rangkaian Driver Relay (Perancangan, 2016)

Pada perancangan rangakaian driver relay menggunakan IC optocoupler yang berfungsi
sebagai pemisah atau isolasi antara tegangan kecil dengan tegangan yang lebih besar. Pada
perancangan ini menggunakan IC Optocoupler 4N35. Prinsip kerja driver relay ketika sisi
anoda dan katoda diberikan tegangan OV maka pada sisi kolektor dan emitor akan open
circuit sehingga tidak ada arus yang mengalir pada coil relay dan relay tidak aktif. Begitu

juga sebaliknya ketika sisi anoda dan katoda diberikan tegangan 5V maka pada sisi kolektor
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dan emitor akan terjadi short circuit yang mengakibatkan coil relay teraliri arus dan relay
mulai aktif.

3.8.4. Pembuatan Rangkaian Sensor Suhu DS18B20

Sensor suhu berfungsi sebagai feedback dalam sistem pengendalian pada plan
pengeringan biji kopi. Pada penelitian kali ini menggunakan sensor suhu DS18B20 yang
mempunyai jenis komunikasi serial one-wire. Adapun sensor suhu DS18B20 yang

dihubungkan dengan arduino uno ditunjukkan dalam Gambar 3.5.

Gambar 3.5 Koneksi Sensor DS18B20

Sensor suhu DS18B20 memiliki 3 pin koneksi, yaitu antara lain:
= VCC (5V)

» GND

= DATA

Seperti yang ditunjukkan dalam Gambar 3.5, data sensor mempunyai keluaran digital

yang dihubungkan dengan arduino melalui resistor pull-up.

3.8.,5. Pembuatan Rangkaian LCD 16x2

LCD 16x2 berfungsi untuk menampilkan karakter tulisan. Pada penelitian ini LCD 16x2
difungsikan sebagai penampil atau display yang digunakan untuk menampilkan data suhu
pada proses pengeringan biji kopi.



26

17=J

L

Gambar 3.6 Rangkaian LCD 16x2 (Perancangan, 2016)

Selain itu, status dari Heater dan fan akan ditampilkan juga pada LCD. Adapun

rangkaian LCD 16x2 yang dihubungkan dengan arduino uno ditunjukkan dalam Gambar 3.6.

3.8.6. Perancangan Parameter Metode Kontrol On-Off

Perancangan parameter metode kontrol on-off bertujuan agar diperoleh respon
pengendalian pada plan yang sesuai dengan yang diharapkan. Pengeringan biji kopi yang
optimal menggunakan suhu 47°-60°C (Najiyati dan Danarti, 2004). Pada penelitian ini
menggunakan setpoint suhu pada plan sebesar 55°C. Agar diperoleh hasil respon
pengendalian suhu yang dapat steady di setpoint dan juga mengurangi ripple pada respon
suhu maka diperlukan penentuan nilai hysteresis. Nilai hysteresis pada penelitian ini

menggunakan nilai sebesar 47°C. Adapun ilustrasi nilai hysteresis ditunjukkan dalam

Gambar 3.7.

ON

Hysterisis

Control Output

OFF

47°C

55°C

Temperature

Gambar 3.7 Nilai Setpoint dan Hysteresis (Perancangan, 2016)

Berdasarkan ilustrasi gambar nilai setpoint dan hysterisis dapat diketahui bahwa nilai

setpoint sebesar 55°C dan nilai hysterisis sebesar 47°C.
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3.8.7. Perancangan Perangkat Lunak

Perancangan perangkat lunak pada penelitian ini menggunakan compiler arduino.ide.
Sebelum menulis program pada arduino, terlebih dahulu dilakukan perancangan flowchart

sistem. Adapun flowchart sistem ditunjukkan dalam Gambar 3.8.

4 )

MULAI

INISIALISASI SISTEM

Setpoint; Input; Error;
Hysteresis High;
Hysteresis Low;

BACA SENSOR
SUHU();

APAKAH SUHU
<= 47°C?

HEATER = “ON”

APAKAH SUHU
>=510C?

HEATER = “OFF”

SELESAI

\. J

Gambar 3.8 Flowchart Perangkat Lunak Sistem (Perancangan, 2016)

Pada flowchart perangkat lunak sistem yang dirancang, yang pertama kali dilakukan
adalah inisialisasi variabel. Kemudian setelah itu program akan memulai membaca suhu.
Suhu yang sudah dibaca akan diperiksa apakah sudah mencapai pada titik setpoint. Dari hasil
pemeriksaan akan menentukan logika untuk mengaktifkan atau menonaktifkan Heater.



BAB IV
HASIL DAN PEMBAHASAN

Tujuan pengujian sistem ini adalah untuk menentukan apakah alat yang telah dibuat
berfungsi dengan baik dan sesuai dengan perancangan. Pengujian pada sistem ini meliputi
pengujian setiap blok maupun pengujian secara keseluruhan. Pengujian setiap blok ini
dilakukan untuk menemukan letak kesalahan dan mempermudah analisis pada sistem
apabila alat tidak bekerja sesuai dengan perancangan. Pengujian dibagi menjadi beberapa
bagian, yaitu:

1. Pengujian Catu Daya

2. Pengujian LCD 16x2

3. Pengujian Sensor Suhu DS18B20

4. Pengujian Sistem Keseluruhan

4.1.Pengujian Catu Daya

Pengujian ini bertujuan untuk mengetahui tegangan catu daya yang akan digunakan
pada arduino, LCD16x2, relay, sensor suhu.
4.1.1. Peralatan Pengujian

Pengujian dilakukan menggunakan peralatan sebagai berikut:
1. Catu Daya
2. Digital Multimeter FLUKE 111

4.1.2. Prosedur Pengujian

Pengujian dilakukan dengan cara menghubungkan kutub positif catu daya dengan probe
positif multimeter, dan juga kutub negatif catu daya dengan probe negatif multimeter.

Kemudian hasil pengukuran dicatat yang kemudian dihitung nilai error nya.

28
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4.1.3. Hasil Pengujian

Hasil pengujian tegangan catu daya ditunjukkan dalam Gambar 4.1

Gambar 4.1 Pengukuran Catu Daya

Dari hasil pengujian yang dilakukan, dapat diketahui bahwa catu daya mempunyai

error:
error = VPengukuran - VStandart (4-1)
=12,30 V - 12V
=0,30V
- |VPengukuran_Vstandart|
error(%) = X 100% (4.2)
Vstandart
dengan,
Vpengukuran = tegangan catu daya yang diukur
Vstandart = tegangan standar catu daya yang tertera di name plate.
error = |12,30 — 12| Ay
12
error = 12.16%
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Terjadi error sebesar 2,5%, namun tegangan tersebut masih dapat ditoleransi oleh

arduino dan rangkaian lainnya.

4.2. Pengujian LCD 16x2

Pengujian ini bertujuan untuk menguji fungsional dari LCD 16x2. Dimana hasil yang
diharapkan adalah LCD 16x2 dapat menampilkan karakter tulisan sesuai dengan program

yang dimasukkan.

4.2.1. Peralatan Pengujian

Pengujian dilakukan menggunakan peralatan sebagai berikut:
1. Power Supply 12 Volt

2. Arduino Uno

3. LCD 16x2

4. Laptop

4.2.2. Prosedur Pengujian

Pengujian dilakukan dengan cara menghubungkan power supply pada arduino uno.
Kemudian arduino diberikan program untuk menampilkan hasil pembacaan sensor suhu
dan status dari heater.

4.2.3. Hasil Pengujian

Hasil pengujian LCD 16x2 ditunjukkan dalam Gambar 4.2.

Gambar 4.2 Hasil Pengujian LCD 16x2

Dari hasil pengujian LCD 16x2 yang ditunjukkan dalam Gambar 4.2 diketahui bahwa
LCD 16x2 dapat menampilkan tulisan karakter sesuai dengan program yang dimasukkan

pada arduino.
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4.3. Pengujian Sensor Suhu DS18B20

Pengujian sensor suhu bertujuan untuk mengetahui karakteristik dari sensor suhu
DS18B20 ketika melakukan proses pembacaan dan pengukuran suhu.
4.3.1. Peralatan Pengujian

1. Sensor Suhu DS18B20
2. Termometer Raksa
3. Catu Daya 5V

4. Bejana dengan air panas

4.3.2. Prosedur Pengujian

Pengujian dilakukan dengan cara memasukkan sensor suhu DS18B20 dan juga
termometer air raksa ke dalam bejana dengan isi air panas. Kemudian suhu yang terbaca
pada termometer air raksa dibandingkan dengan pembacaan sensor suhu DS18B20. Hasil

pengujian kemudian dicatat dan dianalisis.

4.3.3. Hasil Pengujian

Hasil pengujian sensor suhu DS18B20 ditunjukkan dalam Tabel 4.1

Tabel 4.1 Hasil Pengujian Sensor Suhu DS18B20

Suhu Suhu
No. [ Termometer DS18B20
€©) 0
1 63 61,5
2 60 58,9
3 55 54
4 50 48,8
5 47 46,6
6 44 43,6
7 40 39
8 38 37,7
9 35 34,2
10 30 29,3
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Grafik hasil pengujian sensor suhu DS18B20 ditunjukkan dalam Gambar 4.3.

70

60

50

40

30 =f=>S5uhu Termometer

Suhu [Celsius)

20 —— Suhu DS18B20

10

0

Pengujian Ke -

Gambar 4.3 Grafik Pengujian Sensor DS18B20

Berdasarkan hasil pengujian sensor suhu yang ditunjukkan dalam Tabel 5.3 dan Gambar
5.3 dapat diketahui bahwa sensor suhu dapat berfungsi sebagaimana mestinya. Hal ini dapat
dilihat dari hasil pengukuran sensor suhu DS18B20 yang Mengikuti trend pembacaan sensor

suhu termometer air raksa.
4.4. Pengujian Keseluruhan Sistem

Pengujian keseluruhan sistem bertujuan untuk mengetahui respon kontroler yang
digunakan untuk mengendalikan suhu pada alat pengering biji kopi. Selain itu pengujian

juga bertujuan untuk menguji sistem pengering yang telah dirancang.

4.4.1. Peralatan Pengujian

Pengujian dilakukan menggunakan peralatan sebagai berikut:
Arduino Uno

Sensor Suhu DS18B20

Modul Relay

. Heater

. Power Supply

. Biji Kopi

~N o 0o~ W DN P

. Laptop
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4.4.2. Prosedur Pengujian

Untuk melakukan pengujian keseluruhan sistem yang pertama kali dilakukan adalah
menyiapkan biji kopi yang akan dikeringkan. Sebelum dimasukkan pada alat pengering, biji
kopi dicuci dengan menggunakan air. Kemudian biji kopi yang akan dikeringkan ditimbang
terlebih dahulu. Kemudian setelah itu biji kopi dimasukkan ke dalam alat pengering dan alat
mulai diaktifkan selama 10 jam. Data pengujian yang berupa suhu ruangan pengeringan dan

sinyal kontrol dicatat melalui serial monitor pada laptop.

4.4.3. Hasil Pengujian

Proses menyiapkan biji kopi yang akan dikeringkan ditunjukkan dalam Gambar 4.4 dan
4.5.

Gambar 4.5 Proses Penimbangan Biji Kopi Sebelum Dikeringkan
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Proses menyiapkan biji kopi dilakukan dengan cara mencuci biji kopi kemudian
menimbang berat biji kopi yang akan dikeringkan. Berdasarkan hasil penimbangan
didapatkan berat 1,625 Kg biji kopi. Kemudian proses pengeringan biji kopi dilakukan
selama 10 jam. Hasil pengujian pengeringan biji kopi ditunjukkan dalam Gambar 4.6 dan
4.7.

OVERSHOOT

VTV WYY VU VYUV U YUV UURVY!

——Temperature |

GANGGUAN

Suhu (Celcius)

— Hysterisis

20 M —Setpoint
10 T
D < -
0 1 2 2 a 5 6 7 2 Q 10
Waktu (Jam)
Gambar 4.6 Grafik Suhu Terhadap Waktu
1 — —
E
§
Z
s Sinyal Kontrol
0 T
0 0 0 0 0 0 0 0 0 0 0
Waktu (Jam)

Gambar 4.7 Grafik Sinyal Kontrol Terhadap Waktu

Berdasarkan hasil pengujian yang ditunjukkan dalam Gambar 4.6 dan 4.7 menunjukkan
bahwa respon plan mempunyai Time Delay (Td) = 6 menit, Time Rise (Tr) = 9 menit, Time
Peak (Tp) = 12 menit dan Max Overshoot (Mp) = 59,19°C. Pada pengujian keseluruhan

sistem dilakukan gangguan atau disturbance dengan cara membuka ruangan pemanas.



35

Setelah proses pengeringan selama 10 jam, biji kopi dikeluarkan dari ruang pengeringan dan

kemudian ditimbang beratnya.

Gambar 4.8 Penimbangan Biji Kopi Setelah Dikeringkan

Setelah proses penimbangan biji kopi didapatkan berat biji kopi 1,29 Kg. Terjadi
penyusutan berat biji kopi sebesar 335 Gram setelah melalui proses pengeringan,

ditunjukkan dalam Gambar 4.8.



BAB V

PENUTUP

5.1. Kesimpulan

Dari perancangan, pengujian dan pengamatan yang telah dilakukan pada penelitian

pengendalian suhu pada alat pengering biji kopi menggunakan metode kontroler on-off

maka dapat diambil kesimpulan sebagai berikut :

1.

Sistem pengendalian suhu pada alat pengering biji kopi menggunakan metode
kontrol On-Off dapat melakukan proses pengeringan selama 10 jam dan dengan
mempunyai respon plan Time Delay (Td) = 6 menit, Time Rise (Tr) =9 menit, Time
Peak (Tp) = 12 menit dan Max Overshoot (Mp) = 59,19°C. Terjadi penyusutan
berat biji kopi sebesar 335 Gram pada saat sebelum dilakukan proses pengeringan

dibandingkan dengan setelah proses pengeringan.

2. Penentuan parameter kontrol On-Off dengan menggunakan hysterisis. Dimana
setpoint suhu sebesar 55°C dan nilai hysterisis sebesar 47°C.
5.2. Saran

Dalam perancangan dan pembuatan alat ini masih terdapat beberapa kelemahan.

Untuk memperbaiki alat pengeringan biji kopi dan untuk pengembangan lebih lanjut

disarankan:
1. Menambah kapasitas dimensi ruang pengeringan agar didapatkan hasil pengeringan
yang lebih banyak.
2. Dibutuhkan sensor yang dapat mengukur kadar air pada kopi selama proses
pengeringan.
3. Menggunakan metode yang lain sebagai perbandingan dari metode on-off.
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Arduino UNO
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Product Overview

The Arduino Uno is a microcontroller board based on the ATmega328 (datasheet). It has 14 digital
input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz crystal
oscillator, a USB connection, a power jack, an ICSP header, and a reset button. It contains
everything needed to support the microcontroller; simply connect it to a computer with a USB
cable or power it with a AC-to-DC adapter or battery to get started. The Uno differs from all
preceding boards in that it does not use the FTDI USB-to-serial driver chip. Instead, it features the
Atmega8U2 programmed as a USB-to-serial converter.

"Uno" means one in Italian and is named to mark the upcoming release of Arduino 1.0. The Uno
and version will be the reference versions of Arduno, moving forward. The Uno is the latest in a

series of USB Arduino boards, and the reference model for the Arduino platform; for a comparison

with previous versions, see the index of Arduino boards.



http://www.atmel.com/dyn/resources/prod_documents/doc8161.pdf
http://arduino.cc/en/Main/Boards
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Summar

Microcontroller ~ ATmega328

Operating Voltage 5V Input Voltage (recommended) 7-12V
Input Voltage (limits) 6-20V
Digital 1/0 Pins 14 (of which 6 provide PWM output)
Analog Input Pins 6
DC Current per 1/0
Pin 40 mA DC Current for 3.3V Pin 50 mA
Flash Memory 32 KB of which 0.5 KB used by bootloader
SRAM 2 KB
EEPROM 1 KB
Clock Speed 16 MHz

the board

MADE :
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The Arduino Uno can be powered via the USB connection or with an external power supply. The
power source is selected automatically. External (non-USB) power can come either from an AC-to-
DC adapter (wall-wart) or battery. The adapter can be connected by plugging a 2.1mm center-
positive plug into the board's power jack. Leads from a battery can be inserted in the Gnd and Vin
pin headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however,
the 5V pin may supply less than five volts and the board may be unstable. If using more than 12V,
the voltage regulator may overheat and damage the board. The recommended range is 7 to 12
volts.

The power pins are as follows:

¢ VIN. The input voltage to the Arduino board when it's using an external power source
(as opposed to 5 volts from the USB connection or other regulated power source). You
can supply voltage through this pin, or, if supplying voltage via the power jack, access it
through this pin.

e 5V. The regulated power supply used to power the microcontroller and other
components on the board. This can come either from VIN via an on-board regulator, or
be supplied by USB or another regulated 5V supply.

e 3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50
mA.

e GND. Ground pins.

The Atmega328 has 32 KB of flash memory for storing code (of which 0,5 KB is used for the
bootloader); It has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with
the EEPROM library).

Input and Output

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(),
digitalWrite(), and digitalRead() functions. They operate at 5 volts. Each pin can provide or
receive a maximum of 40 mA and has an internal pull-up resistor (disconnected by default) of

20-50 kOhmes. In addition, some pins have specialized functions:

e Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data.
TThese pins are connected to the corresponding pins of the ATmega8U2 USB-to-TTL
Serial chip .

e External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a
low value, a rising or falling edge, or a change in value. See the attachinterrupt() function
for details.

e PWM: 3,5,6,9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function.

e SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication,



http://www.arduino.cc/en/Reference/EEPROM
http://arduino.cc/en/Reference/PinMode
http://arduino.cc/en/Reference/DigitalWrite
http://arduino.cc/en/Reference/DigitalRead
http://arduino.cc/en/Reference/AttachInterrupt
http://arduino.cc/en/Reference/AnalogWrite
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which, although provided by the underlying hardware, is not currently included in the
Arduino language.

e LED: 13. Thereis a built-in LED connected to digital pin 13. When the pin is HIGH value,
the LED is on, when the pin is LOW, it's off.

The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different
values). By default they measure from ground to 5 volts, though is it possible to change the
upper end of their range using the AREF pin and the analogReference() function. Additionally,

some pins have specialized functionality:
e I°C: 4 (SDA) and 5 (SCL). Support I°C (TWI) communication using the Wire library.
There are a couple of other pins on the board:
e AREF. Reference voltage for the analog inputs. Used withanalogReference().
¢ Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset
button to shields which block the one on the board.

E’ Radlospares RADIONICS

ALLIED ELECTRONICS
AN ELECTRDCOMPONENTS COMPANY


http://arduino.cc/en/Reference/AnalogReference
http://arduino.cc/en/Reference/Wire
http://arduino.cc/en/Reference/AnalogReference
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Communication

The Arduino Uno has a number of facilities for communicating with a computer, another Arduino,
or other microcontrollers. The ATmega328 provides UART TTL (5V) serial communication, which is
available on digital pins 0 (RX) and 1 (TX). An ATmega8U2 on the board channels this serial
communication over USB and appears as a virtual com port to Software on the computer. The '8U2
firmware uses the standard USB COM drivers, and no external driver is needed. However, on
Windows, an *.inf file is required..

The Arduino Software includes a serial monitor which allows simple textual data to be sent to
and from the Arduino board. The RX and TX LEDs on the board will flash when data is being
transmitted via the USB-to- serial chip and USB connection to the computer (but not for serial
communication on pins 0 and 1).

A SoftwareSerial library allows for serial communication on any of the Uno's digital pins.

The ATmega328 also support 12C (TWI) and SPI communication. The Arduino Software includes
a Wire library to simplify use of the 12C bus; see the documentation for details. To use the SPI
communication, please see the ATmega328 datasheet.

e programming
The Arduino Uno can be programmed with the Arduino Software (download). Select "Arduino
Uno w/ ATmega328" from the Tools > Board menu (according to the microcontroller on your
board). For details, see the reference and tutorials.

The ATmega328 on the Arduino Uno comes preburned with a bootloader that allows you to

upload new code to it without the use of an external hardware programmer. It communicates
using the original STK500 protocol (reference, C header files).

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit
Serial Programming) header; see these instructions fordetails.

The ATmega8U2 firmware source code is available . The ATmega8U2 is loaded with a DFU
bootloader, which can be activated by connecting the solder jumper on the back of the board

(near the map of Italy) and then resetting the 8U2. You can then use Atmel's FLIP Software

(Windows) or the DFU programmer (Mac OS X and Linux) to load a new firmware. Or you can

use the ISP header with an external programmer (overwriting the DFU bootloader).
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http://www.arduino.cc/en/Reference/SoftwareSerial
http://arduino.cc/en/Reference/Wire
http://arduino.cc/en/Main/Software
http://arduino.cc/en/Reference/HomePage
http://arduino.cc/en/Tutorial/HomePage
http://arduino.cc/en/Tutorial/Bootloader
http://www.atmel.com/dyn/resources/prod_documents/doc2525.pdf
http://www.atmel.com/dyn/resources/prod_documents/avr061.zip
http://dev.arduino.cc/wiki/uno/Hacking/Programmer
http://www.atmel.com/dyn/products/tools_card.asp?tool_id=3886
http://www.atmel.com/dyn/products/tools_card.asp?tool_id=3886
http://dfu-programmer.sourceforge.net/
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Automatic (Software) Reset

Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is
designed in a way that allows it to be reset by Software running on a connected computer. One of
the hardware flow control lines (DTR) of the ATmega8U2 is connected to the reset line of the
ATmega328 via a 100 nanofarad capacitor. When this line is asserted (taken low), the reset line
drops long enough to reset the chip. The Arduino Software uses this capability to allow you to
upload code by simply pressing the upload button in the Arduino environment. This means that the
bootloader can have a shorter timeout, as the lowering of DTR can be well-coordinated with the
start of theupload.

This setup has other implications. When the Uno is connected to either a computer running Mac
OS X or Linux, it resets each time a connection is made to it from Software (via USB). For the
following half-second or so, the bootloader is running on the Uno. While it is programmed to ignore
malformed data (i.e. anything besides an upload of new code), it will intercept the first few bytes
of data sent to the board after a connection is opened. If a sketch running on the board receives
one-time configuration or other data when it first starts, make sure that the Software with which it
communicates waits a second after opening the connection and before sending this data.

The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the
trace can be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to
disable the auto-reset by connecting a 110 ohm resistor from 5V to the reset line; see this forum
thread for details.

The Arduino Uno has a resettable polyfuse that protects your computer's USB ports from shorts and
overcurrent. Although most computers provide their own internal protection, the fuse provides an
extra layer of protection. If more than 500 mA is applied to the USB port, the fuse will automatically
break the connection until the short or overload is removed.
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How to use Arduino

Arduino can sense the environment by receiving input from a variety of sensors and can
affect its surroundings by controlling lights, motors, and other actuators. The microcontroller

on the board is programmed using the Arduino programming language (based on Wiring)

and the Arduino development environment (based on Processing). Arduino projects can be
stand-alone or they can communicate with Software on running on a computer (e.g. Flash,
Processing, MaxMSP).

Arduino is a cross-platoform program. You'll have to follow different instructions for your
personal OS. Check on the Arduino site for the latest instructions.

http://arduino.cc/en/Guide/HomePage

Linux Install Windows Install Mac Install

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via
USB cable.

Blink led

Now you're actually ready to “burn” your first program on the arduino board. To select

“plink led”, the physical translation of the well known programming “hello world”, select

File>Sketchbo
ok> Arduino-
0017>Example
S>

Digital>Blink
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http://arduino.cc/en/Reference/HomePage
http://wiring.org.co/
http://www.processing.org/
http://arduino.cc/en/Guide/HomePage
http://arduino.cc/en/Guide/HomePage
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Once you have your skecth
you'll see something very
close to the screenshot on
the right.

In
Tools>Bo
ard select
Now you
have to go

to

Tools>SerialPort

B Blink | Arduino 0017 - AxX

File: Sketch  Tools Help

int ledPin = 13; A4 LED commected to digital pin 13

A4 The setup() method runs once, when the sketch starts

woid setup () {
A4 initialize the digital pin as an output:
pinMode (ledPin, OUTPUT)

i

£ the loopi) method runs over and owver again,
A4 as long as the Arduino has power

woid loop ()
{
digitalWrite (ledPin, HIGH): A4 get the LED on
delay(1000) ;2
digitallWrite (ledPin, LOW):
delay(l000) ;

A4 walt for a second
£¢ set the LED off
A4 wait for a second

and select the right serial port, the one arduino is attached to.

° Done compiling.

Press Compile buffon
(to check for errors)

e

‘]zmb o

&

TX RX Flashing

Blinking Led!
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Dimensioned Drawing
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Terms & Conditions 90]

Warranties

1.1  The producer warrants that its products will conform to the Specifications. This warranty lasts for one (1) years from the date of
the sale. The producer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer,
including improper installation or testing, or for any products that have been altered or modified in any way by a Customer.
Moreover, The producer shall not be liable for any defects that result from Customer's design, specifications or instructions for
such products. Testing and other quality control techniques are used to the extent the producer deems necessary.

1.2  If any products fail to conform to the warranty set forth above, the producer's sole liability shall be to replace such products. The
producer's liability shall be limited to products that are determined by the producer not to conform to such warranty. If the producer
elects to replace such products, the producer shall have a reasonable time to replacements. Replaced products shall be warranted
for anew full warranty period.

1.3 EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." THE PRODUCER
DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED
TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE

14  Customer agrees that prior to using any systems that include the producer products, Customer will test such systems and the
functionality of the products as used in such systems. The producer may provide technical, applications or design advice, quality
characterization, reliability data or other services. Customer acknowledges and agrees that providing these services shall not
expand or otherwise alter the producer's warranties, as set forth above, and no additional obligations or liabilities shall arise from
the producer providing such services.

1.5 The Arduino™ products are not authorized for use in safety-critical applications where a failure of the product would reasonably
be expected to cause severe personal injury or death. Safety-Critical Applications include, without limitation, life support devices
and systems, equipment or systems for the operation of nuclear facilities and weapons systems. Arduino™ products are neither
designed nor intended for use in military or aerospace applications or environments and for automotive applications or
environment. Customer acknowledges and agrees that any such use of Arduino ™ products which is solely at the Customer's risk,
and that Customer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

1.6 Customer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related
requirements concerning its products and any use of Arduino™ products in Customer's applications, notwithstanding any

applications-related information or support that may be provided by the producer.

Indemnification

The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against any and all third-party
losses, damages, liabilities and expenses it incurs to the extent directly caused by: (i) an actual breach by a Customer of the representation
and warranties made under this terms and conditions or (ii) the gross negligence or willful misconduct by the Customer.

Consequential Damages Waiver
In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental,
consequential or exemplary damages in connection with or arising out of the products provided hereunder, regardless of whether the

producer has been advised of the possibility of such damages. This section will survive the termination of the warranty period.

Changes to specifications

The producer may make changes to specifications and product descriptions at any time, without notice. The Customer must not rely on
the absence or characteristics of any features or instructions marked "reserved" or “undefined.” The producer reserves these for future
definition and shall have no responsibility whatsoever for conflicts or incompatibilities arising from future changes to

them. The product information on the Web Site or Materials is subject to change without notice. Do not finalize a design with this
information.



Enviromental Policies

The producer of Arduino™ has joined the
Impatto Zero® policy of LifeGate.it. For each
Arduino board produced is created / looked
after half squared Km of Costa Rica’s
forest’s.
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